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About This Document

This document explains how to use the WebLogic Process Integrator™ Worklist
application. The document is organized as follows:

n Chapter 1, “Worklist User Interface,” provides instructions for starting and 
exiting the worklist and navigating the worklist user interface.

n Chapter 2, “Task Menu,” describes the functions of the Task pull-down menu
commands.

n Chapter 3, “Workflow Menu,” describes the Workflow pull-down menu 
commands.

n Chapter 4, “Customization: View Menu,” explains how to customize the workl
by using the View pull-down menu commands.

n Chapter 5, “Tools Menu,” describes the functions of the Tools pull-down men
commands.

What You Need to Know

This document is intended for end users who are assigned and will be executing
workflow tasks.
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e-docs Web Site

BEA product documentation is available on the BEA corporate Web site. From the 
BEA Home page, click on Product Documentation or go directly to the “e-docs” 
Product Documentation page at http://e-docs.beasys.com.

How to Print the Document

You can print a copy of this document from a Web browser, one file at a time, by u
the File—>Print option on your Web browser.

A PDF version of this document is available on the WebLogic Process Integrato
documentation Home page on the e-docs Web site (and also on the documenta
CD). You can open the PDF in Adobe Acrobat Reader and print the entire docum
(or a portion of it) in book format. To access the PDFs, open the WebLogic Proc
Integrator documentation Home page, click the PDF files button, and select the 
document you want to print.

If you do not have the Adobe Acrobat Reader, you can get it for free from the Ad
Web site at http://www.adobe.com/.
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Related Information

The following BEA WebLogic Process Integrator documents contain information that 
is relevant to using this product.

n BEA WebLogic Process Integrator Tutorial

n BEA WebLogic Process Integrator Studio Guide

n BEA WebLogic Process Integrator Installation and Configuration Guide

n BEA WebLogic Process Integrator Javadoc

n BEA WebLogic Process Integrator Release Notes

Contact Us!

Your feedback on the BEA WebLogic Process Integrator documentation is important 
to us. Send us e-mail at docsupport@beasys.com if you have questions or comments. 
Your comments will be reviewed directly by the BEA professionals who create and 
update the WebLogic Process Integrator documentation.

In your e-mail message, please indicate which release of the BEA WebLogic Process 
Integrator documentation you are using.

If you have any questions about this version of BEA WebLogic Process Integrator 
worklist, or if you have problems installing and running the worklist, contact BEA 
Customer Support through BEA WebSupport at www.beasys.com. You can also 
contact Customer Support by using the contact information provided on the Customer 
Support Card, which is included in the product package.

When contacting Customer Support, be prepared to provide the following information:

n Your name, e-mail address, phone number, and fax number

n Your company name and company address

n Your machine type and authorization codes
BEA WebLogic Process Integrator Worklist User Guide vii



n The name and version of the product you are using

n A description of the problem and the content of pertinent error messages

Documentation Conventions

The following documentation conventions are used throughout this document.

Convention Item

Ctrl+Tab Indicates that you must press two or more keys simultaneously.

italics Indicates emphasis or book titles.

monospace 
text

Indicates code samples, commands and their options, data structures and 
their members, data types, directories, and file names and their extensions. 
Monospace text also indicates text that you must enter from the keyboard.

Examples:

#include <iostream.h> void main ( ) the pointer psz

chmod u+w *

\tux\data\ap

.doc

tux.doc

BITMAP

float

monospace 
italic 
text

Identifies variables in code.

Example:

String expr

UPPERCASE 
TEXT

Indicates device names, environment variables, and logical operators.

Examples:

LPT1

SIGNON

OR
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{} Indicates a set of choices in a syntax line. The braces themselves should 
never be typed.

[] Indicates optional items in a syntax line. The brackets themselves should 
never be typed.

Example:

buildobjclient [-v] [-o name] [-f file-list]... 
[-l file-list]...

| Separates mutually exclusive choices in a syntax line. The symbol itself 
should never be typed.

... Indicates one of the following in a command line: 

n That an argument can be repeated several times in a command line

n That the statement omits additional optional arguments

n That you can enter additional parameters, values, or other information

The ellipsis itself should never be typed.

Example:

buildobjclient [-v] [-o name] [-f file-list]... 
[-l file-list]...

.

.

.

Indicates the omission of items from a code example or from a syntax line. 
The vertical ellipsis itself should never be typed.

Convention Item
BEA WebLogic Process Integrator Worklist User Guide ix
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CHAPTER
1 Worklist User Interface

The following sections describe the worklist and explain how to use the WebLogic 
Process Integrator Worklist interface:

n Overview

n Starting the Worklist

n Viewing Workflow Status

n Using the Worklist Interface

n Exiting the Worklist
BEA WebLogic Process Integrator Worklist User Guide 1-1



1 Worklist User Interface
Overview

You use the WebLogic Process Integrator Worklist application to view, perform, and 
work with tasks that are currently assigned to you or to the roles to which you belong. 
Various workflow commands enable you to reassign tasks to other users, mark tasks 
as done, unmark tasks done, view a workflow status, manually start a workflow, and 
more.

The Worklist is the primary user interface for WebLogic Process Integrator. You can 
customize the interface to suit your needs.

Starting the Worklist

To start the Worklist application from your desktop, choose Start > Programs > 
WebLogic Process Integrator > Worklist to display the Logon dialog box.

Figure 1-1   Logon to WebLogic Process Integrator Dialog Box
1-2 BEA WebLogic Process Integrator Worklist User Guide
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Enter the following information in the Logon dialog box:

n User Name—User ID of the user who is connecting to the WebLogic Process
Integrator Worklist application.

n Password—Password for the specified user.

n Server[:port]—Name or IP address of the WebLogic Process Integrator serve
which you connect.

Viewing Workflow Status

After you log on to Worklist and if notification is turned on, a workflow status dialo
box displays the total number of pending tasks (tasks waiting to be done) as well a
total number of overdue tasks, if any.

For information on the notification functionality, refer to “Options Command.”

Figure 1-2   Workflow Status
BEA WebLogic Process Integrator Worklist User Guide 1-3



1 Worklist User Interface
Using the Worklist Interface

The Worklist window may contain a series of tabs, depending on whether you are a 
member of a role. A role is a common area of responsibility, ability, or authorization 
level that is shared by a group of individuals. A single user can belong to one or more 
roles.

The first tab contains your WebLogic Process Integrator user ID and shows the tasks 
that have been assigned only to you. The remaining tabs contain the names of the roles 
to which you belong. Selecting a role tab displays the tasks associated with that role 
only. Only you can execute tasks displayed in your user ID tab. However, any user who 
belongs to a role can execute a task assigned to that role.

The information displayed in the Worklist window depends on the selected 
organization. An organization can represent different business entities, geographical 
locations, or any other distinction relevant to the particular business of the company. 
Use the drop-down list to the right of the window to select the organization for which 
you want to view task information; the Worklist window displays the user ID and role 
tabs corresponding to each organization to which you belong. Information is displayed 
only for those organizations to which a user belongs.

Note: If you belong to only one organization, the organization drop-down list is not 
displayed in the Worklist window.
1-4 BEA WebLogic Process Integrator Worklist User Guide



Using the Worklist Interface
Figure 1-3   Worklist User ID Tab

Figure 1-4   Worklist Role Tab
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1 Worklist User Interface
Worklist Task Columns

Each task in the Worklist window displays various properties, depending on how the 
worklist is tailored. These properties are displayed as columns in the worklist:

n Task—Name of the task within the workflow.

n Workflow Name—Name of the workflow template.

n Workflow Label—Workflow ID, defined in the Template Definition properties 
dialog box. This ID can be a built expression.

n Due—Date by which the task must be completed.

n Started—Date the task was activated.

n Priority—Task priority: low, medium, high.

n Comment—Comments about the task.

Worklist Toolbar

The following table describes the various Worklist toolbar commands. These 
commands correspond to menu commands; however, the menus contain many 
commands that are not shown on the toolbar.

Table 1-1  Worklist Toolbar Commands

Symbol Purpose

Start a new workflow.

View the workflow associated with the selected 
task.
1-6 BEA WebLogic Process Integrator Worklist User Guide



Exiting the Worklist
The worklist is a dynamic list. When new work is assigned to users, a task 
automatically appears in the list. As work is performed, the task status may change 
automatically. Tasks can be removed from the worklist either automatically or 
manually by the user, if they are reassigned or completed.

Exiting the Worklist

To exit the worklist, choose Task > Exit. Because the WebLogic Process Integrator 
server is responsible for maintaining the actual worklist contents, you do not need to 
save your work. When you exit the worklist, any customization you have done is 
saved.

View the properties for the selected task.

Execute the selected task.

Take ownership of the selected task.

Reassign the selected task.

Table 1-1  Worklist Toolbar Commands

Symbol Purpose
BEA WebLogic Process Integrator Worklist User Guide 1-7
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CHAPTER
2 Task Menu

The following sections explain how to use the various WebLogic Process Integrator 
Worklist Task menu commands:

n Task Menu Overview

n Task Command Permissions

n Task Assignment

n Execute Command

n Mark as Done Command

n Unmark Done Command

n Take Command

n Reassign Command

n Properties Command

n Other Commands
BEA WebLogic Process Integrator Worklist User Guide 2-1
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Task Menu Overview

Use the Task pull-down menu commands to operate on the currently selected task in 
the worklist window. These commands are also available as a pop-up menu that you 
access by right-clicking on a selected task in the worklist. 

Figure 2-1   Task Pull Down Menu

Task Command Permissions

When a task in a workflow is first defined in the WebLogic Process Integrator Studio 
application, certain permissions are set for that task in the Permissions tab of the Task 
Properties dialog box. These permissions determine which commands you can 
perform for a particular task in the Worklist Task menu. Refer to “Using Tasks” in
Chapter 4, “Working with Workflow Components,” of the WebLogic Process 
Integrator Studio User Guide for more information about defining tasks in a workflow
2-2 BEA WebLogic Process Integrator Worklist User Guide
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For example, if the Mark as Done and Reassign permissions are set for a task when it 
is first defined in the Task Properties dialog box, any user, user within a role, or user 
who belongs to a role to which the task is assigned can perform the Mark as Done and 
Reassign commands on the task. Therefore, the commands that can be performed for 
a particular task are dependent on the permissions set at task definition time, and all 
users and roles to which these tasks have been assigned can perform these commands.

Task Assignment

Tasks are assigned in the WebLogic Process Integrator Studio application. Task 
assignment occurs in three venues:

n User—A task is assigned to a particular user ID through the Assign Task to U
action. Only the assigned user can perform the task unless this user reassign
task to another user. (Reassignment can only occur if the Reassign comman
valid, which is dependent on the permissions that are set at the time of task 
definition. Refer to “Using Tasks” in Chapter 4, “Working with Workflow 
Components” of the WebLogic Process Integrator Studio User Guide.) The first 
tab in the Worklist window is the User ID tab containing tasks assigned to yo
user ID.

n Role—A task is assigned to a role. A role is a common area of responsibility,
ability, or authorization level that is shared by a group of individuals (such as
“Buyer” or “Supervisor”). A single user can belong to one or more roles. If yo
belong to roles, each role will be represented by a tab to the right of the User
tab in the Worklist window. Tasks contained within a role tab can be performe
only by users who are members of that role. Any user who is a member of th
role can take a task assigned to the role and execute the task.

To do a task assigned to a role, the user belonging to the role must first selec
the task in the Role tab and choose Take from the Task menu. This action mo
the task to the user’s User ID tab, where the user can execute the task.
BEA WebLogic Process Integrator Worklist User Guide 2-3
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n User in a role—A task is assigned to a user in a role through the Assign to R
member option of the Assign Task to User action dialog box. The system 
automatically assigns the task to the user within the selected role who has th
least number of tasks to perform. Refer to “Assign Task to User” in Chapter 5
“Actions,” of the WebLogic Process Integrator Studio User Guide for more 
information.

Execute Command

Use the Execute command to perform a task.

The Execute command is the most common operation in the worklist. It is equiva
to double-clicking a task in the list. The Execute command sends a message to 
WebLogic Process Integrator server to perform the actions defined in the task’s 
executed event.

The actual behavior of the Execute command depends on the definition of the ta
defined by the workflow designer at workflow definition time. It commonly results
an application or program being called. Sometimes, the result of the Execute com
is the completion of the task, although this also depends on the definition of the ta
workflow design time.

Tasks can usually be executed only if they are pending and have been assigned
user or a role to which the user belongs.
2-4 BEA WebLogic Process Integrator Worklist User Guide
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Mark as Done Command

Use the Mark as Done command to change the status of a task to done.

This command sends a message to the WebLogic Process Integrator server to set the 
task completion date to the current date and then perform the actions defined for the 
marked done event of the task. Like the Execute command, the behavior of the Mark 
as Done command is determined by the definition of the task at workflow design time. 
Tasks can only be marked done if their properties allow it. Refer to “Properties 
Command” for more information.

Unmark Done Command

Use the Unmark Done command to reset task status from done to pending.

This command sends a message to the WebLogic Process Integrator server to cl
task completed date. It does not affect a task that is not complete. Tasks can on
unmarked done if their properties allow it. Refer to “Properties Command” for mo
information.

Take Command

Use the Take command to take a task assigned to a role to which you belong and
the task in your personal task list for execution.

When you execute the Take command, a message is sent to the WebLogic Proc
Integrator server to change the task assignment. The task is removed from the r
worklist and placed in your personal (User ID tab) worklist. you can only take a t
if its properties allow for task reassignment and if the task is not already done. R
to “Properties Command” for more information.
BEA WebLogic Process Integrator Worklist User Guide 2-5
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Reassign Command

Use the Reassign command to reassign a task to another user, to a user in a role, or to 
a role. When you choose this command, the Reassign Task dialog box is displayed.

Figure 2-2   Reassign Task 

You can reassign a task if the following are true:

n The task to be reassigned is currently assigned to you individually, to you as a 
user in a role, or to a role to which you belong.

n The task permissions allow the task to be reassigned, and the task properties 
assigned to the task include Reassign at Execution. Refer to “Properties 
Command” in this document and to “Using Tasks” in Chapter 4, “Working with
Workflow Components,” in the WebLogic Process Integrator Studio User Guide 
for more information.

You can reassign a task as follows:
2-6 BEA WebLogic Process Integrator Worklist User Guide
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n To another user—In the Reassign Task dialog box, select User. In the Assign
drop-down list, select another user in the same organization associated with 
workflow containing the task.

n To a user in a role—This reassignment option is available only if the Assign 
Task to User task action has been defined to include the Assign to Role mem
option. (See “Assign Task to User” in Chapter 5, “Using Actions,” in the 
WebLogic Process Integrator Studio User Guide.) In the Reassign Task dialog 
box, select User in a role. In the Assignee drop-down list, select a role. At 
execution time, the system performs workload balancing by automatically 
assigning the task to the user in that role who is assigned the least number o
current tasks.

n To a role—In the Reassign Task list box, select Role. In the Assignee drop-d
list, select any role that is in the organization associated with the workflow 
containing the task.

Properties Command

Use the Properties command to display and change properties of the selected ta
Choose Properties to display the Task Properties dialog box.
BEA WebLogic Process Integrator Worklist User Guide 2-7
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Figure 2-3   Task Properties

A worklist user can only set task properties if the relevant permissions are set for the 
task in the Permissions tab of the Task Properties dialog box in the WebLogic Studio 
application. These permissions directly correspond to the commands that can be 
performed for a particular task from the worklist Task menu. For more information, 
refer to “Using Tasks” in Chapter 4, “Working with Workflow Components” of the
WebLogic Process Integrator Studio User Guide.

The Task Properties dialog box contains the following:

n Task Name—Shown for informational purposes only and cannot be modified

n Priority—Task priority: High, Medium, or Low.

n Task permissions—Determine what a user can do with a task from the workli
Available permissions include:

l Modify at execution—If selected, the task permissions can be changed. If
selected, none of the task permissions can be altered from the Properties
command.
2-8 BEA WebLogic Process Integrator Worklist User Guide
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l Mark done without executing—If selected, the Mark As Done command c
be performed on the task. The task’s completed date can be set manually
the user.

l Re-execute if marked done—If selected, the Execute command can be 
performed on the task even if the task has already been completed.

l Unmark if marked done—If selected, the Unmark Done command can be
performed on the task.

l Reassign at execution—If selected, the Take and Reassign commands ca
performed on the task.

Other Commands

The Task menu also contains the following commands:

n Logon—Logs you on to the WebLogic Process Integrator server after you ha
previously executed the Logoff command.

n Logoff—Logs you off of the WebLogic Process Integrator server but leaves th
worklist application running.

n Exit—Logs you off of the WebLogic Process Integrator server and shuts dow
the worklist application.
BEA WebLogic Process Integrator Worklist User Guide 2-9
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CHAPTER
3 Workflow Menu

The following sections explain how to use the various WebLogic Process Integrator 
Worklist Workflow menu commands:

n Workflow Menu Overview

n Start a Workflow Command

n Workflow Status Command
BEA WebLogic Process Integrator Worklist User Guide 3-1
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Workflow Menu Overview

The Workflow pull-down menu contains a list of commands relating to current 
workflows for which a user is assigned tasks. 

Figure 3-1   Workflow Pull-down Menu

Workflow menu commands can be performed by any user or member of a role to 
which a workflow task is assigned. No special permissions are required other than task 
assignment.

Start a Workflow Command

Use the Start a Workflow command to start a workflow manually. Any user that has a 
valid worklist account can manually start a workflow using this command.

Choose this command to display the Start Workflow dialog box, which shows all 
available workflow template definitions marked “Manually Startable.” Such 
workflows are marked “Active” and “Manual” start during workflow template 
definition. (For more information, refer to “Specifying Workflow Definition 
Properties” in Chapter 3, “Defining and Maintaining Workflows” and “Using Start
in Chapter 4, “Working with Workflow Components” of the WebLogic Process 
Integrator Studio User Guide.)

The Start Workflow dialog box also displays the list of defined organizations to wh
you belong. You manually start a workflow for any organizations in this list.
3-2 BEA WebLogic Process Integrator Worklist User Guide



Start a Workflow Command
Figure 3-2   Start Workflow Dialog Box

Select the organization and a workflow to start. Click OK to start the workflow. A 
message is sent to the WebLogic Process Integrator server to start the workflow. The 
processing depends completely on the definition of the workflow.
BEA WebLogic Process Integrator Worklist User Guide 3-3



3 Workflow Menu
You see the following message when the workflow starts successfully.

Figure 3-3   Workflow Successfully Started

Workflow Status Command

Use the Workflow Status command to display a list of all of the tasks associated with 
the workflow of the selected task.

Figure 3-4   Workflow Status Dialog Box

You can access task commands by right-clicking on a task in the Workflow Status 
dialog box. These commands are identical to those accessed through the Task menu. 
For more information, refer to Chapter 2, “Task Menu.”
3-4 BEA WebLogic Process Integrator Worklist User Guide



Workflow Status Command
Figure 3-5   Task Commands
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CHAPTER
4 Customization: View 
Menu

The following sections explain how to customize the WebLogic Process Integrator 
worklist by using the various View menu commands:

n View Menu Overview

n Refresh Command

n Pending Command

n Done Command

n Inactive Command

n Columns Command

n Sort By Command

n Look and Feel Command
BEA WebLogic Process Integrator Worklist User Guide 4-1



4 Customization: View Menu
View Menu Overview

Use the View menu commands to customize the display of the worklist and the 
behavior of the worklist application.

Figure 4-1   View Menu

Refresh Command

The Refresh command instructs the WebLogic Process Integrator server to update the 
status of tasks on the worklist.
4-2 BEA WebLogic Process Integrator Worklist User Guide



Pending Command
Pending Command

The Pending command displays all pending tasks in the worklist. A pending task has 
not been executed yet.

Done Command

The Done command displays all tasks that have been completed.

Inactive Command

The Inactive command displays all inactive tasks in the worklist. Inactive tasks are 
tasks that have not been started in the workflow. 
BEA WebLogic Process Integrator Worklist User Guide 4-3



4 Customization: View Menu
Columns Command

The Columns command displays a dialog box in which you can customize the worklist 
display. The Columns dialog box contains a listing of all columns for a task.

Figure 4-2   Columns Dialog Box

The dialog box shows columns currently displayed. Show columns or hide currently 
displayed columns by using the Add and Remove buttons. Alter column sequence by 
using the Up and Down buttons. The Reset button undoes any changes made.

After you make your column selections, the worklist display changes to reflect the new 
column layout.
4-4 BEA WebLogic Process Integrator Worklist User Guide



Sort By Command
Sort By Command

The Sort By command submenu lists all columns that can be shown for a task. 
Selecting a single column sorts the worklist tasks according to the value of the selected 
column.

Figure 4-3   Sort By Command Submenu

The Sort By submenu contains a series of radio button selections that represent the 
column headings in the worklist. Selecting a radio button sorts the worklist according 
to the values of that column. You can also sort tasks in the worklist by clicking the 
appropriate column heading on the Worklist window. Clicking a second time on a 
column heading changes the sort sequence, toggling between ascending and 
descending order.

If you select the Ascending checkbox in the Sort By submenu, the tasks in the worklist 
are sorted in ascending order (by the selected column heading). If the Ascending 
checkbox is not selected, the tasks in the worklist are sorted in descending order.
BEA WebLogic Process Integrator Worklist User Guide 4-5



4 Customization: View Menu
Look and Feel Command

The Look and Feel command contains a submenu of display options. Depending on 
your preference, you can choose one of three common user environments for the 
worklist display:

n Metal

n Common Desktop Environment (CDE)/Motif 

n Windows

Figure 4-4   Look and Feel Command Submenu
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CHAPTER
5 Tools Menu

The following sections explain how to use the various WebLogic Process Integrator 
Worklist Tools menu commands:

n Tools Menu Overview

n Display Logon Status Command

n Change Password Command

n Options Command
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5 Tools Menu
Tools Menu Overview

The Tools pull-down menu contains a list of commands that you use to display your 
logon status, change your password, and view your worklist options.

Figure 5-1   Tools Menu

Display Logon Status Command

Use the Display Logon Status command to enable or disable the logon status window. 
When this option is selected and logon first occurs, the Workflow Status dialog box is 
displayed. This dialog box shows the total number of pending tasks (tasks waiting to 
be done) as well as the total number of overdue tasks, if any.

Note: Notification must be enabled in order to use this command. For instructions, 
refer to “Options Command.”
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Change Password Command
Figure 5-2   Workflow Status

Change Password Command

Use the Change Password command to change your worklist password. Note that this 
command only becomes available if you are running WebLogic Process Integrator 
using a manageable security realm. By default, the WebLogic Process Integrator 
security realm is non-manageable.

Figure 5-3   Change Password Dialog Box

Enter your current password in the Current Password field. Enter your new password 
twice in the New Password field and in the Confirm New Password field. Click OK to 
confirm the change.
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5 Tools Menu
Options Command

Use the Options command to set up the automatic notification mechanism for new task 
arrival and the refresh rate of the worklist.

The worklist is a dynamic list that is always changing to reflect the current state of the 
workflow system. Enabling notification allows the worklist to be configured to notify 
you when new tasks have been automatically added to your personal worklist.

Notification of new tasks can be enabled or disabled. If enabled, the maximum 
frequency with which notification messages are displayed can be set. For example, you 
might not want notification more than every five minutes, so as to not disturb your 
work.

When notification is turned on and a new task is assigned to you, the following type of 
notification dialog box appears:

Figure 5-4   New Task Notification
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Options Command
Choose the Options command to display the Worklist Options dialog box.

Figure 5-5   Worklist Options Dialog Box

The Worklist Options dialog box contains the following:

n Enable task notifications — If selected, task notifications will be sent.

n Play audio file — You can assign a WAV or AU audio file to the notification 
tool so that when you receive a notification, this audio file will play. Click the 
button to the right of this field to display the Audio Notification dialog box.
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5 Tools Menu

nds) 
Figure 5-6   Audio Notification Dialog Box

n Seconds between successive notifications — Enter the interval time (in seco
between notifications.
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